PI-based Historian with ControlST* Software Suite System Guide

Dec 2018

Public Information
These instructions do not purport to cover all details or variations in equipment, nor to provide for every possible contingency to be met during installation, operation, and maintenance. The information is supplied for informational purposes only, and GE makes no warranty as to the accuracy of the information included herein. Changes, modifications, and/or improvements to equipment and specifications are made periodically and these changes may or may not be reflected herein. It is understood that GE may make changes, modifications, or improvements to the equipment referenced herein or to the document itself at any time. This document is intended for trained personnel familiar with the GE products referenced herein.

GE may have patents or pending patent applications covering subject matter in this document. The furnishing of this document does not provide any license whatsoever to any of these patents.

Public Information – This document contains non-sensitive information approved for public disclosure.

GE provides the following document and the information included therein as is and without warranty of any kind, expressed or implied, including but not limited to any implied statutory warranty of merchantability or fitness for particular purpose.

For further assistance or technical information, contact the nearest GE Sales or Service Office, or an authorized GE Sales Representative.

Revised: Dec 2018
Issued: Jun 2009


* Indicates a trademark of General Electric Company and/or its subsidiaries. All other trademarks are the property of their respective owners.

We would appreciate your feedback about our documentation. Please send comments or suggestions to controls.doc@ge.com
Document Updates

<table>
<thead>
<tr>
<th>Rev</th>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Throughout document</td>
<td>Replaced E: with X: as an install target directory drive and added a Note that X in the target directory indicates a user-selected location</td>
</tr>
<tr>
<td></td>
<td>WorkstationST Historian</td>
<td>Removed configuration procedures and replaced with a reference to the WorkstationST Historian Configuration Instruction Guide (GEI-100628) for those procedures</td>
</tr>
</tbody>
</table>

Acronyms and Abbreviations

- BOP: balance of plant
- EGD: Ethernet Global Data
- EMT: Ethernet Global Data Management Tool
- HMI: Human-machine Interface
- OEM: Original Equipment Manufacturer
- PDH: plant data highway
- SOE: sequence of events
- UDH: unit data highway

Related Documents

<table>
<thead>
<tr>
<th>Doc #</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>GEH-6422</td>
<td>Turbine Historian System Guide</td>
</tr>
<tr>
<td>GEI-100628</td>
<td>WorkstationST Historian Configuration Instruction Guide</td>
</tr>
<tr>
<td>GEI-100752</td>
<td>Historian Report Configuration Instruction Guide</td>
</tr>
<tr>
<td>GEI-100753</td>
<td>Historian Report Post-installation Instruction Guide</td>
</tr>
<tr>
<td>GEA-S1218</td>
<td>Mark Vle ICS - Historian Fact Sheet</td>
</tr>
<tr>
<td>GEA-S1230</td>
<td>ControlST Embedded Short-term Historian Fact Sheet</td>
</tr>
<tr>
<td>GEH-6808</td>
<td>ControlST Software Suite How-to Guides</td>
</tr>
</tbody>
</table>
Contents

1 Overview ................................................................................................................................. 5
  1.1 Data Collection and Storage ........................................................................................... 7
  1.2 PI-based Applications ....................................................................................................... 8

2 Installation ............................................................................................................................... 9
  2.1 PI-based Application Installation ..................................................................................... 9
    2.1.1 Installing PI-based Application .................................................................................. 9
    2.1.2 Installing the PISMTSetup CD ............................................................................... 13
    2.1.3 Installing the PI OPC Interface .............................................................................. 16
    2.1.4 Installing the PI Enterprise Data Access ............................................................... 18
    2.1.5 Installing the PI Combo ......................................................................................... 20
    2.1.6 Installing OPC Historical Data Access (HDA) ...................................................... 23
    2.1.7 Configuring the DCOM Default Users .................................................................. 24
    2.2 Installing Historian Reports ......................................................................................... 26

3 Configuration .......................................................................................................................... 27
  3.1 Setting Excel Options ........................................................................................................ 27
  3.2 Setting PI ProcessBook Options ...................................................................................... 31
  3.3 Time Synchronization Configuration .............................................................................. 33
  3.4 Historian Archives ........................................................................................................... 34
    3.4.1 Data Compression ......................................................................................................... 35
    3.4.2 PI Point Database ........................................................................................................ 35
    3.4.3 Adding Archives .......................................................................................................... 37
  3.5 WorkstationST Historian ................................................................................................. 39
  3.6 Backup of Historical Data ............................................................................................... 40
    3.6.1 PI Backup Procedure ................................................................................................. 40
    3.6.2 Storing PI Archives ................................................................................................... 42
    3.6.3 Restoring Offline PI Archives .................................................................................... 42
  3.7 Historian Report Configuration ....................................................................................... 43
  3.8 Variable Aliasing .............................................................................................................. 43
  3.9 Upgrading an Existing Historian System for Variable Aliasing ...................................... 46

4 User Guide .............................................................................................................................. 47
  4.1 PI-based Server Tags ......................................................................................................... 47
  4.2 Deleting or Renaming a Variable from the PI-based Historian ........................................ 50
  4.3 PI ProcessBook ................................................................................................................. 53
    4.3.1 Creating and Configuring Preferences ...................................................................... 53
    4.3.2 Creating a ProcessBook Entry .................................................................................. 61
    4.3.3 Tag Search ................................................................................................................ 64
    4.3.4 Sample Trend ............................................................................................................. 67
  4.4 Working with ToolboxST Trend ..................................................................................... 69

5 Troubleshooting ...................................................................................................................... 73
  5.1 Verifying Data Flow .......................................................................................................... 73
    5.1.1 Report Configuration Errors .................................................................................... 78
    5.1.2 Automatic Report Generation Errors ....................................................................... 78

Index ......................................................................................................................................... 79
1 Overview

The PI-based Historian is a data archival system, based on OSIsoft™ PI client-server technology. It provides data collection and storage of power distribution and auxiliary process data for display in the WorkstationST* application. It can be configured for turbine-related data and balance of plant (BOP) process data.

The Mark* Vle and Mark VI controllers use the Ethernet Global Data (EGD) unit data highway (UDH) as the communications network between individual turbine unit controllers and system operator components, as well as Human-machine Interfaces (HMI).

Note On a Historian computer, the default drive X:\docs contains customer documentation.

X in the target directory indicates a user-selected location (user can select the target directory during installation).

The Historian system comes with a standard upgradable original equipment manufacturer (OEM) license, which is required for a functional Historian. The OEM server has limited connections. There are six interface licenses, which can be used to collect and place data in the Historian system. The normal interface is an OLE for Process Control Data Access (OPC® DA) client to the WorkstationST OPC DA server installed on the same computer as the OSI® PI application. The system can be connected to six different OPC DA servers, including six power blocks with independent OPC DA servers.

There is a 10-client connection limit on the OEM software license. A client connection is required any time a PI ProcessBook® or PI DataLink® connects to the Historian. If more than 10 client connections are required, there is an upgrade to a 25-client connection.

The OSIsoft OPC DA/HDA server is also supplied with the OEM PI-based server. The license is based on the number of client connections to OPC DA/HDA server of two, 10, or 25 connections. With the OPC DA/HDA server, the ToolboxST* Trender can retrieve historical data from the OSI PI server and the WorkstationST Recorder through the WorkstationST application installed on the Historian computer. The OPC HDA connection only retrieves the data. Two connections can support multiple Trenders. This feature is available in WorkstationST version 3.2 and above.

The PI ProcessBook application displays trends of the historical data, which can be timed-based or cross plots of two tags. Graphic screens can also be created using the Historical tags. The PI DataLink allows the use of historical data in third-party applications such as Microsoft Excel®.
The WorkstationST application allows the local computer to obtain data from all consumed EGD devices through the OPC DA server. The local computer, through the WorkstationST application and the EGD configuration server, automatically receives updates for any configuration change to EGD variables. The OPC DA server provides communication between the HMI and Mark VIe components, as well as the CIMPLICITY* application, ToolboxST Trender, and PI-based applications. The PI-based OPC interface receives its data from the WorkstationST OPC DA server, and passes it to the PI-based server. The PI-based server compresses the data, based on user-defined compression settings, and stores it in the PI-based archives.
1.1 Data Collection and Storage

The Historian communicates on a plant data highway (PDH) and a unit data highway (UDH). Supervisory data is exchanged between Historian and operator stations, engineering workstations, and printers on the Information Network in redundant or non-redundant configurations. Data is sent from components on the UDH using EGD protocol to the OPC DA server on WorkstationST computers. The PI-based OPC interface connects the PI-based System to the WorkstationST OPC DA server. The PI-based OPC interface does not need to be installed on the same computer as the PI-based application.

**Note** Further setup is required to configure the WorkstationST application and PI-based applications if the PI-based OPC interface and the PI-based server are on separate computers.

The PI-based Historian OPC interface samples data from control systems on the control network once per second. Data values and time stamps originate in the controller. For alarms, events, and sequence of events (SOE), data is received on an exception basis. Since time synchronization is essential for determining the root cause of an event, the data can be synchronized to ±1 ms time accuracy between a controller and local time server or ±2 ms time coherence between control systems.

The PI-based application stores data in a series of archives. As each archive fills, the data rolls over to the next archive until all archives are full. The oldest archive is then overwritten. Exception data is stored by the alarm server in files matching the exception data type: alarm, event, SOE, holds, or diagnostics.

The actual amount of data storage available in the archives depends on the data exception and compression settings. Tighter deadbands produce increased data storage and looser deadbands have less data storage.
1.2 **PI-based Applications**

The PI System Management Tool (SMT) allows you to connect to multiple PI-based servers and manage much of the PI-based application. If multiple collectors are used, various plug-ins are used to run the system. Using the SMT application, you can verify the validity of the archives, check disk space for archived variables, run PI-based system backups, connect to multiple servers, and check other issues within the PI-based application.

PI ProcessBook displays real-time and historical data. Users can create custom screens and write scripts to automate displays and trends with Microsoft Visual Basic, which is integrated into PI ProcessBook. OSIsoft also offers other software tools for data analysis. PI ProcessBook is licensed to run on the Historian system. A second license is included to run PI ProcessBook on an HMI. Additional PI ProcessBook licenses can be purchased as needed.

PI ProcessBook can trend any variable stored in the PI-based server. It is fully configurable and can auto-range the scales or set fixed indexes. For accurate read outs, the trend cursor displays the exact value of all variables trended at a given time. The PI ProcessBook can be set up to mimic strip chart recorders, analyze the performance of particular parameters over time, or help troubleshoot root causes of a turbine fault.

PI DataLink provides a connection between the PI system and Microsoft Excel to create reports and perform complex data analysis in a familiar environment. Through Excel, you can import, export, and manipulate data from different PI-based servers.
2 Installation

2.1 PI-based Application Installation

The PI-based application is typically pre-installed on the Historian system.

2.1.1 Installing PI-based Application

The CDs that are required for installing the PI-based application are (in the order given):

1. OEM-GE-HST-MASTER Timeout CD
2. PISMT Setup CD
3. PI OPC interface CD
4. PI Enterprise Data Access CD
5. PI Combo CD
6. PI OPC Historical Data Access (HDA)
7. PI SDK CD
2.1.1.1 Installing the OEM-GE-HST-MASTER Timeout

➢ To install the OEM-GE-HST-MASTER Timeout.exe

1. Place the OEM-GE-HST-MASTER Timeout CD in the CD-ROM drive. Locate the docs folder and copy all files, then paste the files in $X:\docs$. 

![Image of file directory]

<table>
<thead>
<tr>
<th>Name</th>
<th>Type</th>
<th>Size</th>
<th>Date Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>AuditingListServer.pdf</td>
<td>Adobe Acrobat 7.0</td>
<td>589 KB</td>
<td>2/17/2007 11:26 AM</td>
</tr>
<tr>
<td>HA and Replication.pdf</td>
<td>Adobe Acrobat 7.0</td>
<td>869 KB</td>
<td>12/14/2006 9:21 PM</td>
</tr>
<tr>
<td>High Availability Advanced Unit.pdf</td>
<td>Adobe Acrobat 7.0</td>
<td>765 KB</td>
<td>1/18/2007 2:56 PM</td>
</tr>
<tr>
<td>High Availability User Guide.pdf</td>
<td>Adobe Acrobat 7.0</td>
<td>983 KB</td>
<td>10/8/2006 6:02 PM</td>
</tr>
<tr>
<td>Introduction to System Mgmt...</td>
<td>Adobe Acrobat 7.0</td>
<td>1,237 KB</td>
<td>2/17/2007 11:26 AM</td>
</tr>
<tr>
<td>PIReleaseNotes.htm</td>
<td>HTML Document</td>
<td>113 KB</td>
<td>12/14/2006 9:40 PM</td>
</tr>
<tr>
<td>PI Buffer Subsystem User Gui...</td>
<td>Adobe Acrobat 7.0</td>
<td>657 KB</td>
<td>1/12/2006 2:13 PM</td>
</tr>
<tr>
<td>PI Referenced PIRef.pdf</td>
<td>Adobe Acrobat 7.0</td>
<td>1,007 KB</td>
<td>2/17/2006 1:43 PM</td>
</tr>
<tr>
<td>PI Server Installation Guides...</td>
<td>Adobe Acrobat 7.0</td>
<td>1,064 KB</td>
<td>2/17/2006 1:43 PM</td>
</tr>
<tr>
<td>PI Server Installation Guides...</td>
<td>Adobe Acrobat 7.0</td>
<td>2,346 KB</td>
<td>2/17/2006 1:43 PM</td>
</tr>
<tr>
<td>PI Server Reference Guide.pdf</td>
<td>Adobe Acrobat 7.0</td>
<td>1,119 KB</td>
<td>2/17/2006 1:43 PM</td>
</tr>
<tr>
<td>PI Server System Management Guides...</td>
<td>Adobe Acrobat 7.0</td>
<td>2,366 KB</td>
<td>2/17/2006 1:43 PM</td>
</tr>
</tbody>
</table>
From the \nt folder, run the \nOEM_3.4.375.38.exe file.
2. When the **WinZip Self-Extractor** dialog box displays, click the **Unzip** button.

3. Click **OK**. The **PI Server Setup** wizard displays.

![User Information](image)

- **Full Name:** HST_SVR
- **Organization:** DCE_DEMO
- **Serial Number:** ABC123

The settings for this application can be installed for the current user or for all users that share this computer. You must have administrator rights to install the settings for all users. Install this application for:

![Archive Path](image)

- **Archive Path:** D:\pi_arch\default directory.

- **Default Archive Size:** Size of each default archive to be created (MB) 128

![Destination Folder](image)

- **Destination Folder:** C:\PI

4. When the installation is complete, click **OK**.
2.1.2 Installing the PISMTSetup CD

➢➢

To install the PISMTSetup.exe

1. When the WinZip Self-Extractor dialog box displays, click Unzip to display the PI System Management Tools Setup wizard.

When the Welcome wizard displays, click OK.

From the Tools Setup screen, enter the computer name and organization (project), and click Next.
2. When the installation is complete, restart your computer.

From the Start menu, select PI System Management Tool.
**Note** If the temporary license expiration date does not display, contact the nearest GE Sales or Service office of an authorized GE Sales representative.
2.1.3 Installing the PI OPC Interface

➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢➢ği
5. Restart the computer.
2.1.4 Installing the PI Enterprise Data Access

➢➢ To install the PI Enterprise Data Access

1. Place the PI Enterprise Data Access CD in the CD-ROM drive.
2. When the WinZip Self-Extractor dialog box displays, click the Unzip button.
3. When the next two screens display, click Next and Finish.
4. From the CD, locate the PIODBC folder and run the PIODBC_1.2.0_.exe file. The PI ODBC – Installation Folder dialog box displays.
5. Keep the default destination folder and click **Next**.

   - If this message displays, click **Yes**.

   - When you are asked to create a sample PI ODBC Data Source, click **No**.

   - Click **OK** until this message displays, then restart the computer.
2.1.5 Installing the PI Combo

➢ To install the PI combo

1. Place the **PI combo CD** in the CD_ROM drive.

2. From the **WinZip Self-Extractor** dialog box, click the **Unzip** button.
3. Click **OK** in all screens until the installation is complete.

4. From the **WinZip Self-Extractor** dialog box, click the **Unzip** button.
5. Click **OK** in all wizards until the installation is complete, then restart the computer.

From **Documents and Settings**, **Administrator**, and **Local Settings**, locate the **Temp** folder. Delete the folder contents.
2.1.6 *Installing OPC Historical Data Access (HDA)*

The OPC HDA application allows other computers on your network to access the archives. This software is required so that the ToolboxST Trender can retrieve historical data from the PI server.

➢ **To install the OPC HDA application**

1. Place the **PI OPC HDA CD** in the CD-ROM drive and run the **OSIOPC_1_2_6_0_.exe** file.
2. When the installation is finished, restart the computer.

➢ **To configure the OPC HDA server to run as a service**

1. From the **Start** menu, select **Run**.

```
Run

Type the name of a program, folder, document, or Internet resource, and Windows will open it for you.

Open: cmd
```

2. Enter **cmd** in the text box and press **Enter**. The command prompt window displays.
3. From the command prompt, enter **C:\program files\PIPC\PI_OSIOPC** and press **Enter**.
4. From the command prompt, enter **PI_OSIHDA.exe /regserver** and press **Enter**.

*Note* This procedure registers both the OPC HDA server and the OPC DA server. The OPC DA server must be unregistered to continue.

➢ **To unregister the OPC DA server**

1. From the command prompt, enter **C:\program files\PIPC\PI_OSIOPC** and press **Enter**.
2. From the command prompt, enter **PI_OSIOPC.exe /unregserver** and press **Enter**.
2.1.7 Configuring the DCOM Default Users

➢ To configure the DCOM default users

1. From the Component Services dialog box, right-click My Computer and select Properties. The My Computer Properties dialog box displays.
2. From the **My Computer Properties** dialog box, **Launch Permissions** area, click the **Edit Default** button. The **Launch Permission** dialog box displays.

3. From **My Computer Properties**, click the **Edit Limits** button to enable all permissions. Click **OK** and restart the computer.
2.2 Installing Historian Reports

Historian Reports allows you to generate periodic and real-time reports using the historical data.

➢➢➢➢

1. To install the Historian Reports
2. Place the ControlST Software Suite DVD in the CD-ROM drive of the computer.
3. From the Setup — GE ControlST CD dialog box select Historian Reports — Vxx.xx.xxC (PI or Proficy Data reports on the web).
4. Click Yes, then click Install to install the Historian Reports.
5. Click Install.
6. When the installation is complete, click Yes to exit setup.

After installation, the post-installation procedures must be performed. For these instructions, refer to the Historian Report Post-installation Instruction Guide (GEI-100753).
3  Configuration

3.1  Setting Excel Options

➢ To install Excel: from the Start menu, select All Programs, Microsoft Office, and Microsoft Office Excel 2007.

Open Excel 2007 and click Excel Options.
Click Add-Ins, then click Go.
From the Add-Ins dialog box, click Browse...

Locate C:\Program Files\PIPC\Excel, select pipc32.xll, and click OK.
From the Add-ins dialog box, click Browse again, then locate C:\Program Files\PIPC\SMT, select PITagCnf.xla, and click OK.

Close all dialog boxes until the Excel spreadsheet displays the Add-ins tab with PI and PI SMT functions.
3.2 Setting PI ProcessBook Options

➢ To set the PI ProcessBook options: from the Start menu, select All Programs, PI System, and ProcessBook. The PI ProcessBook screen displays.

From the File menu, select Connections.

The PI Connection Manager dialog box displays.

Verify that the Default User Name is piadmin, then from the Tools menu, select Options. The Connection Options dialog box displays.

PI Connection Manager

Server: HST_SVR
Network Node: HST_SVR
Port Number: 5450
Default User Name: piadmin
Connection Timeout: 10 seconds
Data Access Timeout: 60 seconds

Server ID: 49553d54-1c21-4625-8640-9deb6d2f0501
Connection Type: PI3 protocol 3.3
IP Address: 192.168.101.2
PI Version: 3.4.375.38
PI Installation Path: C:\PI
Operating System: Windows NT x86 5.1, 2600
Click the Server Aliases button.

Add localhost and HST (PI server computer name) aliases.
3.3 Time Synchronization Configuration

➢ To synchronize time between the HMI and the Historian

1. From the Start menu, select Control Panel and Date and Time. Click the Time Zone tab.

2. Verify that all system computers are set to the correct time zone and local time.

3. Verify that all configured HMI times are set in the *.tcw file. Refer to the ControlST Software Suite How-to Guides (GEH-6808), the chapter How to Configure Time Synchronization in the ToolboxST Application.

4. On the Historian, locate C:\PI\Dat and rename localhost.tz to localhost.tzold. Changing the file name and restarting the PI server recreates the PI time zone file.

Note This is only required when the time zone of the local Historian is changed.
3.4 Historian Archives

Archives are created as fixed length files and initially contain no data. They are located on the history disk in the pi_arch directory, typically D:\PI_ARCH on the computer with Historian installed. The archives are named PIARCH.\nnn, where \nnn equals a three-digit number that increments for each new archive. The typical archive size is 128 MB. PI archives use roughly 75% of the history disk. The total number of available archives depends on the size of the history disk.

**Note** All new archives must be registered with the PI-based system.

Refer to the *PI-based Server System Management Guide, Chapter 3*, for more information.

On a computer with the Historian system installed, this document is located by default at X:\docs \PiServerSystemManagementGuide.pdf.

**Note** X in the target directory indicates a user-selected location (user can select the target directory during installation).

➢➢ To view a list of registered archives

1. From the Command Prompt, enter \cd /d c:\piadm and press Enter.
2. Enter piartool –al >c:\temp\piarclist.txt and press Enter.
3. Enter notepad c:\temp\piarclist.txt and press Enter.

**Note** When the Historian system is initially installed, all available archives are registered by default. To view a list of archives, run the piartool program, with the parameter –al. The piartool program is located in the C:\PIADM directory.

The list of registered archives displays in Notepad in reverse chronological order with the primary archive listed first. Each archive listed has the associated Start Time and End Time. The archive with a valid Start Time (such as 5-Nov-98 05:37:48) and the value Current Time for the End Time, is the primary archive and should be the first archive listed. An archive with a valid Start Time and a valid End Time was previously the primary archive. Archives with the value Current Time for the Start and End Times have not had data written to them and are therefore currently empty.

Applications residing on the Historian system are the interface between the controllers and the PI-based system, and are responsible for adding data to the PI-based system. The PI-based system shifts from the current primary archive to the next available archive (making it the new primary archive) when an archive reaches its size limit. This next available archive is either an empty archive or the oldest used archive (if an empty one is not available). The PI-based system uses these archives in a circular queue. All data in the registered archives is available to PI-based and GE clients.
3.4.1 Data Compression

The PI-based system has a real-time database controlled by the PI Snapshot subsystem, and a Historian archives controlled by the PI-based data archive subsystem. The application programs that write data to the PI-based system are configured to read controller variables from the OPC DA server once per second. Each variable value is compared to the previous value written to the PI system for that variable. If the value has changed by the variable’s exception deviation (EXCDEV), that variable’s value is written to the PI Snapshot database. The PI Snapshot database saves every variable that is passed to it in the Snapshot.

Whenever a variable is passed into the PI Snapshot, the PI-based data archive subsystem determines if that value should be saved in the archive or discarded. The filter between the application and the PI Snapshot is based on the exception deviation (EXCDEV) value, which is used as a deadband.

**Note** Historical filtering determines whether a variable value is archived or discarded.

The filter between the PI Snapshot and the PI-based data archive is based on the slope of the value, or the first-time derivative of the value. PI uses the compression deviation (COMPDEV) in a swinging door compression algorithm to determine the current slope of the value. If the previous value written falls outside that slope, it is saved in the PI-based data archive subsystem. This greatly reduces the number of samples saved because it filters on the derivative of the value, not on the value itself.

The exception deviation is a deadband on the value, but the compression deviation is a deadband on the slope. More precisely, the value of COMPDEV equals the furthest distance away from the projected slope available without saving another value (thereby projecting a new slope).

3.4.2 PI Point Database

The PI Point Database defines and configures the variables that it maintains. This database can be created either by running an interactive tool or by using a batch processor. The batch processor (PICONFIG) is distributed as part of the normal PI distribution.

3.4.2.1 Naming Conventions

In the Historian, a unit name and a variable uniquely identify values. This scheme allows unit definitions to be duplicated easily by only changing the unit name. The design of the database requires that each tag name be unique. In the old standard for the PI-based application, two or four letters unit names were recommended, with a colon separating the unit name from the point name. The variable is a simple string. The Historian uses the unit’s controller name concatenated with a period and the variable name to uniquely identify each tag, for example **T1.TNH** is the tag name for unit **T1** speed point.

**Note** The PI-based server does not accept a backslash in the variable name. A backslash is replaced with an underscore when the variable is configured in the PI-based application.
3.4.2.2 ASCII Variable Definition File – PICONFIG.DIF

The PICONFIG.DIF file, which is used as the input to the PICONFIG program, is an instance of a generic table modification data file, and contains instructions for the PICONFIG program. It lists the current table and the format of input data being used. When building a Historian in the WorkstationST application, your PICONFIG.DIF file is automatically updated and imported to the system.

3.4.2.3 Importing the Data File

Attention

The WorkstationST Historian automatically creates this file and imports it into the PI-based configuration utility whenever a change is made to the Historian configuration.

Note

The following procedures are not required unless specified by a technician.

The PI-based server must be running to import the PI-based configuration input file. The file is treated as input to the PICONFIG program. The file can be imported through the WorkstationST application or by using one of the following methods:

- Command line interactive
- Command line with input redirected
- Command line with input and output redirected

➢➢ To run command line interactive

1. From the Windows Command Prompt, enter `cd /d c:\pi\adm` and press Enter.
2. Enter `piconfig` and press Enter. Piconfig runs and a piconfig prompt displays.
3. Enter the command `@INPUT f:\piconfig.dif` and press Enter.
4. Enter the command `@EXIT` and press Enter.

➢➢ To run Piconfig with input redirected

1. From the Command Prompt, enter `cd /d c:\pi\adm` and press Enter.
2. Enter `PICONFIG <f:\piconfig.dif` and press Enter. The Piconfig application runs using `f:\piconfig.dif` as the standard input.
3. If the PICONFIG.DIF file does not have an `@EXIT` command at the end, enter `@EXIT`, and exit the program.
➢ To run command line with input and output redirected

1. From the Command Prompt, enter `cd /d c:\pi\adm`.

2. Enter `PICONFIG <f:\piconfig.dif >f:\piconfig.log` and press Enter. The Piconfig program runs using `F:\piconfig.dif` as standard input, and `F:\piconfig.log` as standard output.

**Note** The output from the Piconfig program (status and error messages) is redirected to the log file.

3. If the PICONFIG.DIF file does not have an `@EXIT` command at the end, enter `@EXIT` and exit the program.

### 3.4.3 Adding Archives

➢ To add archives: from the Start menu, select All Programs, PI System, and Management Tools. The PI System Management Tools dialog displays.
The next numerical archive is automatically created.

Click OK. The file is added to the system and registered.
3.5 **WorkstationST Historian**

The WorkstationST Historian is a feature of the WorkstationST application that allows users to configure supported third-party Historians to collect long-term data from the system components. The third-party Historian’s OPC® client is configured to read the data from the WorkstationST OPC Data Access (DA) server. The collected data is accessible through the ToolboxST Trender, as well as the third-party Historian’s data access applications. The WorkstationST Historian supports GE’s Proficy*-based Historian and the OSIsoft PI System® products.

The WorkstationST Historian feature allows users to:

- Configure storage of all data available through the WorkstationST OPC DA server
- Automatically configure variables with a defined Historian Deadband
- Override pre-configured variables
- Add non-configured variables
- Configure Historian reports
- Configure Archive Backup Management

**Note** For WorkstationST Historian configuration procedures and more information, refer to the *WorkstationST Historian Instruction Guide* (GEI-100628).
3.6 Backup of Historical Data

The supported third-party Historian products use fixed-length archives to store data. A set number of archive files are created during factory setup. When these archives are filled, the third-party Historian software reuses the oldest, writeable archive.

Each third-party Historian provides a procedure for backing up archives and configuration information. A description of these procedures is provided.

Note The behavior of the third-party backup procedures may be changed by the third-party software supplier without notice, but is accurate at this time. Refer to the third-party supplier’s documentation for detailed information regarding the backup procedures.

3.6.1 PI Backup Procedure

The file supplied with the PI-based Server for backing up archives and archive configuration information is pibackup.bat. It is located in the PI-based install directory under the \adm folder (typically C:\PI\ADM\PIBACKUP.bat). The pibackup.bat file backs up the current archive, additional archives (if specified), site-specific configuration files, as well as log files to the specified backup directory. On Mondays, it performs a full backup of these files. On all other days, it performs an incremental backup; only files that have changed are backed up. The backup procedure does not delete any previously backed-up files. As data is accumulated and the current archive shifts to the next archive, the older archive remains in the backup directory.

The pibackup.bat file can be run interactively from a Command Prompt or can be scheduled to run at regular intervals using the Task Scheduler.

Note For detailed information on backing up a PI-based Server, refer to the PI Server System Management Guide.

Note Do not schedule pibackup.bat to run if the Historian Archive Backup Manager is scheduled to run.
➢ To enable backups at regular intervals

1. Create a backup directory (such as `X:\backup`).

2. Open a Command Prompt and change directory to `C:\PI\ADM` and run the following command:

   `pibackup.bat X:\backup –install`

   **Note** `X` in the target directory indicates a user-selected location (user can select the target directory during installation).

   The Task Scheduler is now configured to run `pibackup.bat` every day at 03:15 AM, backing up the current archive and the two previous archives, as well as configuration information, to `X:\backup`.

   **Note** To view the `pibackup` online Help, which includes the default parameter values for `pibackup.bat`, enter the following command at the Command Prompt: `pibackup.bat ?`

➢➢

➢➢

➢ To view or edit the task in the Task Scheduler

1. From the Control Panel, double-click Scheduled Tasks.

   **Note** On Windows XP®, Windows® Server 2003, and Windows Vista®, the task is named PI Server Backup. On Windows 2000, the task is named at# where # is a number.

2. Right-click the name and select Properties.

3. If the task name is at#, right-click the name and select Rename. Rename the task to PI Server Backup.
3.6.2 Storing PI Archives

**Note** Store archives and configuration information that are backed up nightly to DVD, CD, or tape.

If the backup directory used by `pibackup.bat` is not on a separate disk that is sized to hold all archives and configuration information, move the older archives to an offline storage medium.

3.6.3 Restoring Offline PI Archives

When required data is no longer available online, restore the necessary archives to a temporary directory. Use PI System Management Tools (PI-SMT) to register the archive.

➢➢➢ To register an archive using PI-SMT

1. From the **Start** menu, select **All Programs**, **PI System**, and **PI System Management Tools**. The **PI-SMT** tool displays.

2. From **Collectives and Servers**, verify that the local **PI Server** is selected.

3. From **System Management Plug-Ins**, expand the **Operation** item and select **Archives**.

4. From the **Summary View**, right-click and select **Display Unregistered Archive**.

5. Browse and select the archive you want to register and click **Open**.

6. From the **PI-SMT** tool, right-click the archive and select **Register This Archive**.

7. From the **PI-SMT** tool, right-click the archive and select **Make Non-shiftable**.

To prevent temporarily restored archives from becoming the primary archive, make temporarily restored archives non-shiftable.

The data from the archive is now available for querying.

**Note** You can register any archive as long as the time range of the data in the archive does not overlap the time range of an archive already registered. The archive names do not have to be different since PI uses the full path of the archive when it registers the archive.
3.7 Historian Report Configuration

Refer to the Historian Report Configuration Instruction Guide (GEI-100752).

3.8 Variable Aliasing

Note Aliases cannot be overridden on the Historian Feature tab.

The Variable Aliasing option allows you to specify an alternate name for a variable (for example, the alias for the gas turbine speed variable, TNH, is specified as SPEED or VELOCIDAD). Aliases are defined where the variable is defined, and must be unique throughout the system.

Note Existing variables in the PI-based Historian cannot be renamed.

➢➢ To enable variable aliasing

From the Tree View, double-click a component (such as G1).

The Component Editor displays.
Each system component can enable alias prefixes. This adds the component name to the beginning of each alias name (for example, G1.Speed).

To create a variable alias

From the **Tree View**, select **Variables**. The variables display in the **Data Grid**.

In the **Data Grid Alias** column, add variable alias names.

To use defined aliases instead of the variable name in the Historian system, the *Use Alias Name* property must be enabled in the Historian WorkstationST component. If a variable alias is not defined, the variable name creates the variable in the Historian system.
➢ To use defined aliases

**Note** Setting the *Enable Alias Prefix* property to True on the Historian WorkstationST only applies the component name prefix to variables defined in the Historian WorkstationST (for example, client-driven variables defined on the OPC DA Server tab).
3.9 Upgrading an Existing Historian System for Variable Aliasing

To maintain continuity of data history when upgrading an existing variable to use an alias, use the PI System Management Tool to rename the original variable (refer to the section Deleting or Renaming a Variable from the PI-based Historian). This must be done before setting the Enable Alias Prefix property to True and performing a Build and Download to the Historian WorkstationST component. If the original variable is not renamed, a new variable with the alias is created.

Attention

Deleting a variable from the Historian system removes all access to the data for that variable.
4 User Guide

4.1 PI-based Server Tags

Note Tags and their parameters can be viewed in Microsoft Excel.

Server tags are the PI-based equivalent of ToolboxST variables. Whenever a Historian WorkstationST is built and downloaded, the tag configuration in the PI-based server is updated. The ToolboxST application converts its variable names that are configured for archiving in PI and updates the PI-based system. Once these tag names are created, the PI-based application uses the PI OPC DA client to connect to the WorkstationST OPC DA server to obtain the variable values. The variable names in the ToolboxST application and the tag names in the PI-based application should be identical with the exception of backslashes replaced by underscores. The application InstrumentTag parameter for the PI tags must be identical to the variable name in the ToolboxST application.

➢ To import tags

From the Windows Start menu, open Microsoft Excel.

Select the Add-ins tab.
Click PI-SMT to display a shortcut menu, then select Import Tags. The Import PI Tags dialog box displays.

Select the All attributes for tag mask specification option button.

The asterisk * indicates a wild card, which imports all tags. To specify tags, precede the * with the tag name.
The following dialog box displays any errors that occurred during the import.

The following is a sample import.
4.2 Deleting or Renaming a Variable from the PI-based Historian

➢ To delete or rename a variable from the PI-based Historian

1. From the Start menu, select Programs, PI System, and PI System Management Tools. The PI System Management Tools displays.
2. From the **Tools** menu, select **Tag search**... The **Tag Search** dialog box displays.
3. Select the variable(s) and click **OK**. The variables display in the **PI System Management Tools** dialog box.

If you selected **Delete PI Point**, the **Delete PI Point Confirmation** dialog box displays.

If you selected **Rename PI Point**, the **Rename PI Point** dialog box displays.
4.3 **PI ProcessBook**

PI ProcessBook is a graphical interface used to display analog and digital data stored in the PI-based server. It can be accessed from the administrator, maintenance, and operator user accounts.

*Note* PI ProcessBook is licensed to run on the Historian and one additional computer.

PI ProcessBook opens a list of PI ProcessBook entries (predefined displays) on the default PI ProcessBook screen. Each PI ProcessBook entry is configured for retrieval and display of variables from the Historian archives. Multiple trends may be defined for a single PI ProcessBook entry. Each trend can display up to eight variables. The time range for each trend can be modified. Trends can simultaneously display historical and real-time data. Additional trends can be added to a PI ProcessBook entry, or new PI ProcessBook entries can be added to the PI ProcessBook.

### 4.3.1 Creating and Configuring Preferences

➢ To create a PI ProcessBook

1. From the **Start** menu, select **All Programs, PI System**, and **PI ProcessBook**.

2. From the **File** menu, select **New**. The **New** dialog box displays.

   ![New dialog box](image)

   *From Type, select ProcessBook (.piw) File, then enter a ProcessBook Name and click OK. The PI ProcessBook dialog box displays.*

3. From the **File** menu, select **Save As** to save the PI ProcessBook.

   ![Save As](image)

   *From the File menu, select Save As to save the PI ProcessBook.*
Note The default settings are stored in either the directory C:\ or C:\Program Files under \PIPC\DAT\PROCBOOK.INI. It is recommended to make a backup copy of this file.

PI ProcessBook has default settings for color, font, start, trend, and each element of a trend.

➢ To configure ProcessBook preferences
4.3.1.1 **Color Tab**

- To change the color

- From the **ProcessBook Preferences** dialog box and the **Color** tab, click the **Choose Colors…** button. The **Color** dialog box displays.

![Color Dialog Box](image)

- Both basic and custom colors can be selected.

- Select the new color and click **Add to Custom Colors** to replace the color. Click **OK** to save the changes.
4.3.1.2 Book Tab

The Book tab defines the fonts that display in the PI ProcessBook titles.

In the Book View Mode, ProcessBook entries are listed on pages in chapters. Each level 1 ProcessBook entry displays as a separate chapter with its own tab. Level 2 and 3 entries are listed on the pages of that chapter with each level indented beneath the previous level.

Note In Book View Mode, only the first three font levels are used (levels 4 through 10 use the Level 3 font).

In the Outline View Mode, entries display in typical outline form with all level 1 entries as separate items in a list (not as separate chapters).

➢➢ To change the font(s)

From the Book tab, select the level and click Choose Font. The Font dialog box displays.
In the Font dialog box, select the desired Font, Font style, and Size. Then click OK.
4.3.1.3 **Start Tab**

➢ To configure Start settings

From the ProcessBook Preferences dialog box, select the Start tab.

**Color**

**Book**

**Start**

**Trend**

**Trend Elements**

- **Author**: is the name or initials of the person creating the ProcessBook (optional).
- **ProcessBook**: is the path and file name for the ProcessBook that displays when the PI ProcessBook client is run.
- **Symbol Library**: specifies the default symbol library used by all ProcessBooks.
- **Preserve Aspect Ratio**: determines that display elements change size in proportion to the window size.
- **Run Mode Bias**: changes the cursor from Build Mode to Run Mode after drawing a new symbol.
- **Create Backup Files**: creates continuous backup files.
- **Time**: determines the time format for trends and values. This property only affects how the time value displays. Either format can still be used for entering a date.
4.3.1.4 Trend Tab

The Trend tab defines settings for new ProcessBook trends.

➢➢ To configure trend settings

![ProcessBook Preferences]

- **Autoscale**, if selected, automatically adjusts the trend scale.
- **Plot Titles**, if selected, displays plot titles.
- **Vertical Scale Inside Axis**, if selected, displays the tag's scale on the inside of the axis.
- **Grids**, if selected, displays grids.
- **Multiple Scales**, if selected, lists each tag's scales on the trend.
- **Markers**, if selected, displays a marker at each saved variable.
- **Style** includes Full time stamp, Partial time stamp, or Relative time stamp.
- **Start** includes *-1 Hour, *-4 Hour, *-8 Hour, *-1 Day, or *-7 Day. A custom time can also be entered. (In the PI system, when referencing time, the asterisk (*) means now. A start time of *-1 Hour means that the Trender is always one hour behind the current time)
- **End** includes *, *-1 Hour, *-4 Hour, *-8 Hour, *-1 Day, and *-7 Day. A custom time can also be entered.
Set the following properties.

**Plot Element** includes:
- Pen 1, 2, 3, 4, 5, 6, 7, 8
- Marker Type
- Color
- Line Style
- Line Weight

Select the **Trend Elements** tab.
4.3.2 Creating a ProcessBook Entry

There are five types of entries: Display, Linked Display, Linked ProcessBook, Text, and Operating System command. The entries can be arranged in hierarchical form by assigning different levels to the entries. An example of entry organization is to assign level 1 entries as text entries that describe the level 2 entries that follow.

➢ To create a new ProcessBook entry: click File, then New. The New dialog box displays.

[Diagram 1: New dialog box with options for selecting entry type]

[Diagram 2: Define ProcessBook Entry dialog box with options for label, type, and level]

From Type, select ProcessBook Entry and click OK. The Define ProcessBook Entry dialog box displays.

Enter the Label for this entry.
Select Text as the Type.
Click OK. The PI ProcessBook displays.
From the **Pi ProcessBook**, click to remove highlight from **3rdShiftOperator Screens**.
➢ To add a display entry under the Text Entry

1. From the File menu, select New. The New dialog box displays.

2. From Type, select ProcessBook Entry, and click OK. The Define ProcessBook Entry dialog box displays.

   ![Define ProcessBook Entry dialog box]

   From the Level drop-down list select 2 to indent Unit 1 – 4 Mwatt Output under 3rdShiftOperator Screens and click OK. The PI ProcessBook displays.

3. Click File, then Save. The empty PI ProcessBook display is saved.
4.3.3 Tag Search

The Tag Search tool is used to search for tags configured in the PI ProcessBook.

➢➢➢ To search for tags

From the Tools menu, select Tag Search. The PI Tag Search dialog box displays.

Use * as the tag mask to search for all configured variables in PI.

Use G3.* to search for variables configured for unit G3 only.

Use *.TNH to search for all speed tags.

The search results display below.

Note The Tag search can be used to highlight multiple tags to add to a trend.
➢ To define a Trend

From the PI ProcessBook Draw menu, select Trend. The cursor changes to a pointer.
On the display, click and drag a box large enough to contain the trend. The **Trend Definition** dialog box displays.

![Trend Definition Dialog Box](image)

Set the following properties:

- **Max** and **Min** determine high and low plot values. The two options for each as follows:
  - **Autorange** causes the limit to vary over time as the tag value changes.
  - **Database** uses the value defined in the PI database (Zero and Span) for that tag as the plot limit.

If multiple tags are used and **Single Scale** is selected, the trend’s plotting limits are the highest **Max:** and the lowest **Min:** from all the tags. If **Multiple Scales** is selected, each tag’s high plot and low plot display.

➢➢ **To review trend attributes**

1. Click the **General** tab.
2. Click the **New Plot** button to open a new Define Trend dialog box for creating multiple trends.
3. Click the **Delete Plot** button to delete the current dialog box, if more than one is open.
4. Click the **Delete Tag** button to delete highlighted tags.
4.3.4 **Sample Trend**

The following example is a trend definition called MWATTS that plots the tag DWATT from each of four units. Since the **End:** time is * and the **Start:** time is * - 8 Hour, the trend continually displays data for the G1.DWATT tag from the previous hour.

➢ **To add tags**

![Define Trend dialog box](image)
From the File menu, select Save, then Close to return to the PI ProcessBook.
4.4 *Working with ToolboxST Trender*

The ToolboxST Trender can interface to the PI-based server if the PI-based OPC HDA server is installed on the Historian.

The ToolboxST Trender graphically displays live and historical data. A Trender can be configured to read I/O values from the PI-based archives, the Recorder, the OPC DA server, or directly from a component. After installing the PI-based OPC DA/HDA server, Trender functions as a Historical display. Trender accesses the PI-based archives through the Historian to look at historical data.

*Note* Refer to GEH-6703, the chapter *Trender*.

➢ To open a Trender

1. From the *Start* menu, select *GE ControlST*, *ToolboxST*, and *Trender*. A *Trender* window displays.

2. When the *Welcome* wizard displays, click *Next*.
Select Historical and click Next.

From the Computer drop-down list, select Hist (the Historian WorkstationST name).
From the Data Source... drop-down list, select Historian.
From the Server: drop-down list, select OSI.HDA.1 and click Next.
From the Select a Variable dialog box, select desired variables and click OK.

The selected variables display in the Add Trace Wizard. Click Finish to display these variables in the Trender.
From the Property Editor, specify the Left Time, Right Time, and Duration of the desired data to retrieve it from the PI archives.
5 Troubleshooting

5.1 Verifying Data Flow

Data flows from the data source (for example, a controller) to the OPC DA server and through the PI-based OPC interface to the PI-based server.

➢➢ To verify data flow to the OPC DA server

1. From the Start menu, select All Programs, GE ControlST, ToolboxST, and ToolboxST to display the System Editor.

2. From the Tree View, double-click the Historian WorkstationST item to display the Component Editor.

3. If the values display green (healthy), verify that the PI-based OPC interface is running and that data is being received by the PI-based server.

4. If the values display red or black (unhealthy), refer to the instructions provided in the ToolboxST User Guide for Mark Controls Platforms (GEH-6703), the chapter Working Online with WorkstationST.
➢ To verify PI OPC operation

1. From the **Start** menu, select **All Programs, PI System**, and **PI.OPCCClient** to display the **PI.OPCCClient**.
Enter a Group Name and click Create.

From the PI_OPCClient, click the Server Browse button to display the Server Browsing dialog box.
2. If the correct values are not displayed, refer to the *WorkstationST OPC DA Server Instruction Guide* (GEI-100621).

3. If the correct values display, open PI System Management Tools.
➢ To verify that data is received

1. From the Start menu, select All Programs, PI System, and PI System Management Tools to display the PI System Management Tools screen.

2. Click Refresh to update the values. If the values display correctly, ControlST is integrated with the PI-based Historian software.
5.1.1 Report Configuration Errors

Report errors, which display when the report is run from the web browser, are controlled by the file X:\site\reports\defaultstyle.css. This file specifies font types, sizes, colors, and the default background colors. Background image files referenced in the defaultstyle.css file are located in the X:\site\reports\images directory. Correct logos are specified in the reports.dat file, with the logo image file located in X:\site\reports\images.

Other report configuration errors, such as incorrect start and stop times, report frequency, or event triggers display when the report is run with an incorrect time period. To correct these errors, adjust the report parameters as needed in the X:\site\reports\reports.dat file to produce the correct data.

Note X in the target directory indicates a user-selected location (user can select the target directory during installation).

When incorrect variable names display in the tag file, the following message displays in the report:

Error executing query: OLE exception from "Microsoft® OLE DB Provider for ODBC Drivers": [OSI][PI-ODBC][PI]Tag < G1.AFPAP > not found Win32::OLE(0.15) error 0x80004005: "Unspecified error" in METHOD/PROPERTYGET "Execute"
SELECT tag, descriptor, engunits, pointtype FROM pipoint WHERE tag = 'G1.DWAT'T or tag = 'G1.AFPAP' or tag = 'G1.MVATHR' or tag = 'G1.MWATTHR'

This is typically a copy of the SQL command that the script is trying to run to get the data, as well as the returned error message. Careful examination of the error message indicates the source of the problem (in this case G1.AFPAP was not found – point name should have been G1.AFPAP).

5.1.2 Automatic Report Generation Errors

Automatic report generation errors are usually related to scheduler problems. Verify that the chain.pl task is scheduled to run every hour. The tasks currently scheduled can be verified on a Windows NT system by opening a command window, and entering at. On a Windows 2000 or later system, the scheduled tasks can be monitored by selecting Start, Programs, Accessories, System Tools, and Scheduled Tasks. Additional information about each task displays in the scheduled task folder. Once the task is scheduled, actions are logged to X:\site\reports\LOG\rpt.log each time the task runs. Any problems encountered, as well as successful completion messages, are logged to this file.
Index

A
Adding Archives  37

B
Backup of Historical Data  40

C
Configuration  27
  Historian Report  43
  Time Synchronization  33
Configuring the DCOM Default Users  24

D
Data Collection and Storage  7
Data Compression  35

E
Errors
  Automatic Report Generation  78
  Report Configuration  78

H
Historian Archives  34

I
Installation  9
Installing Historian Reports  26
Installing OPC Historical Data Access (HDA)  23
Installing PI-based Application  9
Installing the OEM-GE-HST-MASTER Timeout  10
Installing the PI Combo  20
Installing the PI OPC Interface  16
Installing the PI-based Enterprise Data Access  18
Installing the PISMTSetup CD  13

N
Naming Conventions  35

O
Overview  5

P
PI Backup Procedure  40
PI Point Database  35
PI-based Application Installation  9

R
Restoring Offline PI Archives  42

S
Storing PI Archives  42

T
ToolboxST Trender
  Working with  69
Troubleshooting  73

U
Upgrading an Existing Historian System for
Variable Aliasing  46
User Guide  47